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Using Microsoft Word 
 

Text Editing 
A word processor is all about working with large amounts of text, so learning 
the basics of text editing is essential to being able to make the most of the 
program. The first thing we will do is to open an existing document that 
already has a lot of text so you can practice without having to do a lot of 
typing first (not that a good bit of typing practice ever hurts anyone). 

Exercise 1. Opening a Word Document 
Like saving a file, opening a file can be done using the menu, toolbar or a keyboard shortcut. 

1) Use one of the following methods to display the Open File dialog box. 

• Select Open from the File menu. 

• Click the Open icon  on the toolbar. 

• Press [Ctrl] [O]. 

 
2) When the Open dialog appears, use the Look in: list at the top to select the folder where the files 

for these exercises are saved. 

3) Select the file called Word 2003.doc and click the Open button (or double-click on the name of 
the file to open it). 

 
Tip You’ll notice at the bottom of the file menu there is a list of recently opened files. You can 

click a file name in the list to re-open that file. 
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Moving Around a Document 
You can tell how long a document is by checking the status bar at the bottom of the window. For 
example, when you opened the Word 2003 document, the status bar will show that you are on page 
one of a three page document.  
Tip In a large document with a lot of pages, you can double-click the page number indicator 

 and then enter a page number to quickly jump to that page. 

There are many ways to move around a document. One method is to use the vertical Scrollbar on the 
side of the screen. 

Exercise 2. Scrolling Through a Document 
 

 
 

1) Click and hold your mouse on the scroll box as shown above. With the mouse button still held 
down, drag the scroll box downward until it reaches the bottom of the scrollbar. You will now be 
at the end of the document. 

2) Click on the blank space above the scroll box to move up one screen. Repeat this until you reach 
the beginning of the document. 

Split screen marker – can be dragged or double-
clicked down to show different parts of the same
document in a split-screen view 

Click to move up one line at a time 

Click to move down one line at a time 

Scroll box – hold click your mouse button on this
and drag up to quickly move up or down through
the document. Click above the scroll box to move up

one screen at a time. Click below the
scroll box to move down one screen at
a time. 
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Exercise 3. Using the Mouse Wheel to Move Through a Document 
Many computers these days have a mouse which includes a wheel between the 
two main buttons. This mouse wheel feature was introduced by Microsoft for 
the release of Office 97 which included Word 97. Word 97 included features to 
take advantage of the mouse wheel and many other programs have since 
begun to include the same features. If you are using a mouse with a wheel, do 
the following exercise. 

1) Roll the wheel on the mouse downwards. The page will scroll downwards. 
(The mouse setting in Windows will determine how far it scrolls each time you roll the wheel) 

2) Roll the wheel on the mouse downward to scroll the page upward. 

3) Press and hold the wheel. While the wheel is pressed down, move the mouse down gradually to 
scroll down the page. The faster you move the mouse the faster you will scroll.  

 
Note Using the mouse wheel and the scroll bar will change what part of the document is 

appearing on the screen but these methods won’t change the position of the insertion 
point. If you begin typing, the view will immediately change to show where the insertion 
point is. 

 
Tip In Word and many other programs, holding down [Ctrl] while you roll the mouse wheel will 

zoom in and out on the document. 



Using Microsoft Word  Text Editing 

© Steve O’Neil 2005 Page 4 of 12 http://www.oneil.com.au/pc/  

Exercise 4. Moving Using the Keyboard 
Using the keyboard to move around in Word may not be the easiest method to learn as it requires 
remembering key combinations, but for many people it is the quickest method, since you spend most 
of your time in Word with your hands already on the keyboard. Don’t worry if you don’t remember 
all of these. A list of these shortcuts can be found at the end of this section and you will begin to 
remember them with regular use. Note that all of the keyboard methods also move the insertion 
point. 

1) Press the [End] key to move to the end of the current line. 

2) Press the [Home] key to move to the beginning of the current line. 

3) Hold down the [Ctrl] key and press the [End] key. This will take you to the end of the document. 

4) Press [Ctrl] [Home] to move to the beginning of the document. 

5) Hold down [Ctrl] and press the down arrow key [ ]. This will move down one paragraph at a time. 

6) Press [Ctrl] [ ] to move up one paragraph at a time. 

7) Press [Ctrl] [ ] to move right one word at a time. 

8) Press [Ctrl] [ ] to move left one word at a time. 

9) Press [Page Down] to move down one screen at a time. 

10) Press [Page Up] to move up one screen at a time. 

11) Press [Ctrl] [Page Down] to move to the top of the next page. 

12) Press [Ctrl] [Page Up] to move to the top of the previous page. 

13) Return to the beginning of the document when you have tried each of these keyboard shortcuts. 

 
Tip If you have more than one document open in Word, you can use the [Ctrl] [F6] shortcut to 

switch between them. 
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Exercise 5. Inserting and Deleting Text 
Usually when you type text in Word, any existing text will move over to make way for that you type. 

1) Make sure your insertion point is at the beginning of the document (before the text Word 2003). 
Type the word Microsoft followed by a space. The rest of the text will move across so that the 
whole line reads Microsoft Word 2003. 

Caution Sometimes Word may be set to Overtype mode so that what you type replaces existing text 
instead of being inserted in front of existing text. When Overtype mode is turned on and 
indicator will be highlighted in the status bar at the bottom of the window.  You can 
turn overtype off or on by either double-clicking the indicator or by pressing the [Ins] (Insert) 
key. 

Removing text can be done by either the [Delete] key or the [Backspace] key. The difference is that 
pressing the [Delete] key will remove text to the right of the insertion point, while pressing the 
[Backspace] key will move text to the left of the insertion point. 

You can also delete entire words by holding down the [Ctrl] key while you press [Delete] or 
[Backspace]. 

2) Move the insertion point to the second heading just before the word better. 

3) Press [Ctrl] [Backspace] to delete the word More to the left of the insertion point. The heading 
should now read Communicate and Share Information Better. 

4) Edit the text in the first paragraph so that it appears as follows. 

 

Word 2003 is the latest version of the best-selling word processor. Word takes customer experience 
and feedback to deliver many innovations you can use to create more impressive-looking documents 
and help you work better with other people. 
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Selecting Text 
When you are editing a document it is often necessary to select a section of the document. Some of 
the things that require you to select text first include, copying text, moving text and formatting text. 
Since we are going to learn about copying and moving text, we will first look at some different 
methods for selecting text. 

Exercise 6. Selecting Text Using the Mouse 
1) Make sure the Word 2003 document is still open. 

2) Move your mouse pointer to the beginning of the paragraph that begins 
with the words, “Work together better”. When your mouse is over text, the 

mouse pointer changes to a letter “I” shape. 

3) Hold down the mouse button and drag to the end of the paragraph 
until the whole paragraph is selected. When the text is selected, 
the colours become reversed to indicate what part of the text is 
selected. 

4) To de-select the text, click anywhere on the page. If you want to select a large amount of page 
(especially more than one screen’s worth) then it can be difficult to select by dragging. 

5) Click at the beginning of the same paragraph. 

6) Scroll down to the second page and move your mouse (without clicking yet) to the end of the 
paragraph that finishes with the words, “through the thumbnail view”. 

7) Hold down the [Shift] key while you click. Everything in between will be selected. If you want to 
adjust the point where the selection ends, simply hold down [Shift] and click on the new end point. 

8) Move your mouse to the left of the, “Capture and Reuse Information” 
heading. When your mouse is to the left or a row of text, the pointer will 
turn in to a right pointing arrow. 

9) Click to the left of the row to select the entire row. When your mouse is to the left of the text, you 
can also click and drag up or down to select several rows. 

10) Move your mouse over any word in the document. Double-click to select the entire word. Word 
will select everything between two spaces. If you keep your mouse held down on the second 
click and drag left or right, you will select a word at a time. 

11) Make sure no text is selected and move your mouse over any sentence in the document. Hold 
down [Ctrl] and click to select a whole sentence. Word will select everything between two full 
stops but this will only work when there is nothing already selected. 

12) Move your mouse over any paragraph in the document. Triple-click to select the entire 
paragraph. Word will select everything between points where the [Enter] key has been pressed. 

 
Tip If you already have text selected then holding down the [Ctrl] key will allow you to select 

additional text, even if there is a gap between the areas you are selecting. This allows you 
to select more than one area at the same time. 
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Exercise 7. Selecting Text Using the Keyboard 
 For selecting text using the keyboard, the important key to remember is the [Shift] 
key. Earlier we looked at ways to move around a document using keyboard 
shortcuts. If you hold the [Shift] key while using any of the other keyboard 
shortcuts, Word will select all of the text you move over. 

1) Move up to the beginning of the document. 

2) Click at the beginning of the, “Work together better” paragraph. 

3) Hold down the [Shift] key and press the right arrow key [ ]. If 
you keep pressing the [ ] key while holding [Shift] you will increase 
the amount of text selected. 

4) Hold down [Ctrl] and [Shift] at the same time while pressing the [ ] key. This will select one word 
at a time. 

5) Press any arrow key without holding down [Shift]. Moving without holding down the [Shift] key 
will deselect any text you have selected. 

6) You can also use extend mode to select text with the keyboard. 

7) Press [F8] to activate extend mode. An indicator in the status bar will show that 
Extend mode is on. While extend mode is turned on. You can select text without having to hold 
the [Shift] key. Any text you move over will be selected. 

8) Once extend mode is selected, press [F8] again to select a whole word. Pressing it again will 
select a sentence, again for a paragraph and a gain for the whole document. 

9) Press [Esc] to turn off extend mode. Press an arrow key to deselect the text. You can also turn 
extend mode on and off by double-clicking the status bar indicator. 

10) Hold down [Ctrl] and press [A] to select the entire document. 

11) Deselect the text. 
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Copying and Moving Text 
As part of editing text, it is often necessary to rearrange text in a document using copy 
and move techniques. The two methods for moving and copying that will be explained in 
the following exercises are Copy & Paste and Drag & Drop. 

The Copy & Paste method uses the Windows Clipboard. The clipboard is a temporary 
storage tool in Windows that can be used to copy or more information around in a 
program or even from one program to another. It works by placing information, such as 
selected text, in the clipboard and then pasting the information where you want it to go. 

The Drag & Drop method uses the mouse to drag text from one location and drop it in another 
location. 

Exercise 8. Moving Text Using Cut & Paste 
To use Cut & Paste you need to use the following steps. 

a. Select the text you want to move. 

b. Use the Cut command to place the selected text in the clipboard. 

c. Move the insertion point to the position you want the cut text to go. 

d. Use the Paste command to place the information from the clipboard in the destination. 

 

1) Make sure you are on the first page of the Word 2003 document and locate the paragraph that 
begins with, “Designate certain sections”. 

2) Select the sentence at the end of that paragraph which says, “Collaborate with confidence.” 

3) Use one of the following methods to select the Cut command. 

a. Select Cut from the Edit menu. 

b. Click your right mouse button on the selected text and select Cut from the right-click list. 

c. Click the Cut icon  on the toolbar. 

d. Use the [Ctrl] [X] shortcut. 

 

When you cut the text, it will be removed from the document as it is placed in the clipboard. 

4) Move to the beginning of the paragraph and use one of the following methods to select the paste 
command. 

a. Select Paste from the Edit menu. 

b. Click your right mouse button on the selected text and select Paste from the right-click list. 

c. Click the Paste icon  on the toolbar. 

d. Use the [Ctrl] [V] shortcut. 

The text will now be placed at the beginning of the paragraph. 



Using Microsoft Word  Text Editing 

© Steve O’Neil 2005 Page 9 of 12 http://www.oneil.com.au/pc/  

Exercise 9. Moving Text Using Copy & Paste 
The only difference between the Copy command and the Cut command is that the Copy command 
will leave a copy of the selected text at the original location while the Cut command will remove it 
from the original location. 

1) Locate the paragraph that begins with, “Work together better”. In that paragraph you will see 
“™” after, “Microsoft Windows Server”. We will copy this so that it also appears after, 
“SharePoint”. 

2) Select the trademark symbol “™”. 

3) Select the Copy command using one of the following methods. 

a. Select Copy from the Edit menu. 

b. Click your right mouse button on the selected text and select Copy from the right-click list. 

c. Click the Cut icon  on the toolbar. 

d. Use the [Ctrl] [C] shortcut. 

 

4) Move the insertion point so that it is just after the word “SharePoint”. 

5) Paste the copied text. 

 
Note Once you have cut or copied some text to the clipboard, 

you can paste it as many times as you want to make 
multiple copies. In fact, recent versions of Word allow 
you to have more than one bit of text in the clipboard at 
any given time. The task pane can show a list of things 
in the clipboard that can be pasted. An easy way to 
show the Clipboard in the task pane is to select the copy 
command twice. The task pane will show any items you 
have copied to the clipboard. You can click on any item 
in the list to paste it where your insertion point is. 

 
Tip Experienced users of Word often find that the quickest way to use Cut, Copy & Paste is to 

use the keyboard shortcuts. Because the X, C, and V key are all next to the left [Ctrl] key, it 
is very easy to use those shortcuts with your left hand, leaving your right hand to select 
with your mouse. 
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Exercise 10. Drag & Drop Editing 
Another simple way to move and copy text is to use the drag & drop method. This is especially 
useful when you want to quickly move or copy text over short distances in your document. 

1) Locate the paragraph that begins with, “Go mobile”. 

2) Select the last sentence in the paragraph, from, “You can”, to “send to others” (remember you 
can hold down [Ctrl] while clicking to select the entire sentence). 

3) Move your mouse over the selected text and your mouse pointer will be arrow 
shaped. 

4) Hold your mouse down on the selected text and drag to the beginning of the 
paragraph. Release the mouse when your mouse pointer is after, “Go mobile.” 
and, “If you own”. 

5) Save changes to the document and close the file. 

  
Tip If you hold down [Ctrl] while you are dragging selected text, you will be copying instead of 

moving. 

 

6) Open the file called Copying and Moving Practice and follow the instructions in that document 
to practice copying & moving. 
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Exercise 11. Using the Reading Layout View 
Note This feature is not in versions of Word earlier than Word 2003. 

Word documents are generally intended for being read after they have been printed. Sometimes you 
may want to read a document without printing it but the screen layout often makes this difficult. You 
can view your document in different ways in Word and one of these ways is the Reading Layout view. 
The reading Layout view is intended to arrange text in a document so that it is easier to read on the 
screen. This doesn’t change the way it looks when it prints. 

1) Open the Word 2003 document. 

2) You can switch to the Reading Layout view by selecting it from the View menu or 
by clicking the icon in the bottom-left corner of the window. 

 
While in the Reading Layout view, you will notice that the text appears a lot larger and the page is 
re-sized to fit on the screen. You can use the scrollbar or the [Page up] & [Page Down] keys to move to 
different pages in the documents. 

3) Exit the Reading Layout view by clicking the  icon on the toolbar or by pressing the [Esc] 
key. 
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Shortcuts Covered in This Section 
 

Ctrl   or  Move up or down one paragraph at a time 

Ctrl   or  Move left or right one word at a time 

Ctrl  A Select all text in a document 

Ctrl  Backspace Delete a whole word to the left 

Ctrl  C Copy selected text 

Ctrl  Delete Delete a whole word to the right 

Ctrl  End Move to the end of a document 

Ctrl  Home Move to the beginning of a document 

Ctrl  O Open a file. 

Ctrl  PageDown Move to the next page 

Ctrl  PageUp Move to the previous page 

Ctrl  V Paste text from the clipboard 

Ctrl  X Cut selected text 

End Move to the end of a line 

F8 Activate Extend mode for text selection 

Home Move to the beginning of a line 

PageDown Move down one screen 

PageUp Move up one screen 

 


